Fundamentals

Read pages ix–xi in your textbook, Medical Transcription
Fundamentals and Practice. Then read Assignment 1 in this
study guide. Most of the information found in this assignment
isn’t in your textbook.

In addition to your textbook and study guide, this course
also comes equipped with a CD of dictations and a foot pedal
for controlling the speed of the dictations while you’re transcribing. The first step to beginning your transcription will
be to locate the Start Stop software. The download for this,
which is titled “Medical Transcription Start Stop Software
Please Read,” is located on your My Courses page under the
heading “Medical Transcription 1.” Click on the link, and
then follow the instructions. You’ll need to download the
Start Stop software first, and then install the CD found in
the back of your book.

Using the CD
To gain access to the dictations, remove the CD from the
back of your book and insert it into your CD drive. The CD
will open to the course screen (Figure 1).
If your CD doesn’t immediately start to this screen, then use
the following steps to open the CD:
1. Insert the CD into your computer’s CD drive.
2. Right-click the start button in the lower left-hand corner
of your screen.
3. Select Open.
4. Scroll down to your CD drive on the menu (generally the
D, E, or F drive).
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FIGURE 1—Course Screen

5. Double-click the CD drive (You should see the course file
name by the drive MTI3).
6. Click on the MTI3.exe file.
As you can see, the CD screen has different options, including the following:
I

Chapter Selection: An online version of your textbook

I

Transcribe Now: Your dictations for transcribing

I

Learning Activities: Optional activities to help you
practice your transcription skills

I

Visit MT Central: A button to open the book publisher’s
site

I

Get Help: A button to search help topics

I

About This Program: Publishing and synopsis
information

As you’ve probably guessed, you’ll use the Transcribe Now
menu option most. Follow your textbook and study guide for
directions about when to use your CD for each chapter.
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You may also notice other files on your CD. If you open the
CD from your Start menu again, you’ll see a Templates
folder. Templates are formats to make transcribing easier. If
you already work in a medical office, they may have templates for specific reports to ensure that you use the
appropriate layout and format. On your CD, you have the
ability to use templates for
I

Consulting reports

I

Discharge summaries

I

History and physical (H&P)

I

Notes

I

Operative reports

Once you understand how to load and open the software, you
should take some time to familiarize yourself with the layout
and functions of the Transcribe Now portion. To do this, open
the software to the main menu, and click Transcribe Now.
You’ll notice that Chapter 4 is automatically highlighted. This
is the first chapter that has transcription exercises. Click 1.
Chart Note (1:00) to highlight it (Figure 2), and then click
Transcribe Selected Report. An additional screen, where
you’ll transcribe reports, opens (Figure 3).
FIGURE 2—Click 1. Chart
Note (1:00) to highlight it.
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FIGURE 3—You’ll transcribe reports on the
additional screen that
opens.

Transcribing Reports
Beginning in Assignment 5, you’ll transcribe the reports for
each chapter. If you’re confused about the layout or format of
a report, refer to the sample reports in your textbook. Always
read the textbook and study guide prior to transcribing
reports.
You’ll turn in a portion of the transcribed reports as part of
your examinations, but you won’t submit all transcribed
reports for grading. You must still transcribe each report,
however, to gain practice.
When you’re transcribing, it’s helpful to follow this order:
1. Type each report by thinking about what you’re typing.
Thinking about the information and context is a learned
habit that will get easier with practice.
2. Transcribe without editing.
3. Proofread the report after you’re finished and correct any
errors.
4. Flag material, if needed.
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When you’re ready to transcribe the provided dictations,
you’ll open the transcription and dictation window. For now,
open the window and follow along in this portion of the study
guide to give you an understanding and hands-on practice of
using this part of the software.
You should review the pull-down menu options from this
screen. Many of the functions from the pull-down menus are
also listed on the menu bar across the top of the page.

File
If you’re familiar with word processing programs, then you’ll
feel comfortable working with the File menu option (Figure 4).
Clicking on File once pulls down a menu of different options.
From here, you can start a new file, save, e-mail, and print.
FIGURE 4—File Menu
Option

The File menu is where you’ll open templates to use for different reports. To use a template, click on File > New and
choose the type of report from the list (Figure 5).
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FIGURE 5—Templates

This will automatically insert the headings for the chosen
report. Using templates is a good way to remember the layout
of each report. If you don’t want to use a template, click
Blank Report.
After you’ve transcribed your report, click on File > Save As to
save the report. You should always name your transcribed
reports in this way: Chapter#_Report name and number_Your
full name. For example, if your name is Jane Doe and you’re
transcribing the first chart note in Chapter 4, you should save
the transcribed report as Chapter4_ChartNote1_JaneDoe. You
should make a new folder to save your transcriptions for this
course all in one place.

Edit
Again, if you’re familiar with word processing, the Edit function (Figure 6) won’t be new to you. From here, you can copy
and paste text into different sections, delete text, select
blocks of texts, and use the spell checker.
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FIGURE 6—Edit Function

Search
The Search function (Figure 7) allows you to find or replace a
specific word or phrase. This is particularly helpful if you’re
transcribing a lengthy document and realize that you’ve misspelled or incorrectly typed the same word or phrase several
times throughout the document.

Format
The Format function (Figure 8) allows you to set up page layout and how you want paragraphs formatted, tabs setup, or
specific bullet points and fonts.
Setup for these items will depend on certain reports and
where you’re working. For this course, you can leave them as
the default settings.
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FIGURE 7—Search
Function

FIGURE 8—Format
Function
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Tools
The Tools function (Figure 9) makes it possible to start, stop,
or reset the timer that times your typing speed. This is
important because many organizations use typing speed with
accuracy as key factors when hiring transcriptionists.
It’s a good practice to take the “Typing Test” located under
this tab. It’s not a graded test, but it will give you a feel for
where you’re with your current typing speed. As you progress
through the course, it should be a goal to improve your typing speed.
FIGURE 9—Tools Function

Proofread
The Proofread function (Figure 10) is used for proofreading
your transcribed reports after completion. With this function,
you can review, highlight, and tally errors. This will help you
understand weaker areas that need more practice.
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FIGURE 10—Proofread
Function

References
The References menu (Figure 11) provides access to materials
like the style guide and a quick-reference word list from your
CD. If you can’t access these, insert the CD into your computer’s CD drive.
FIGURE 11—References
Menu
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You can also add your own word reference list. This is particularly helpful if you’re working with a specialty that has
unique procedures or supplies that aren’t often found in
other practices.

Setup
The Setup function (Figure 12) is the first thing you should
access when opening this window. It allows you to show or
hide the transcriber, toolbar, ruler, and status bar. When you
mouse over each option, it will show you another window
with the word, “Show.” When there’s a checkmark by “Show”
the specific function is visible on the window. For example,
when you “show” the transcriber, you notice that the transcriber menu appears along the bottom of the screen.
FIGURE 12—Setup
Function

From here, you can start and stop the dictation, see how long
the dictation is, and see your Current Position (Figure 13)—
exactly where you are in the dictation and transcription
(what line, column, and page you’re on). This feature is helpful when flagging a portion of the transcription. You can
include the information in the flag note to your instructor.
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FIGURE 13—Current
Position

For example, if you can’t decipher a word at the 54-second
mark in the dictation, be sure to include that information on
the flag.
A “-” sign appears at the bottom right-hand corner of the
transcriber. If you click on this, the transcription word processing area will disappear. To make it reappear, simply
place your mouse arrow in the very bottom right-hand corner
until you see a message “Show Full Screen” and click your
mouse there.

Help
The Help menu option (Figure 14) allows you to look through
help topics by either content or index. To search on a specific
term or phrase, click the Help > Help Contents > Index tab
and type in the word.
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FIGURE 14—Help Menu Option

ASSIGNMENT 2: MEDICAL
FUNDAMENTALS
Read pages 3–45 in your textbook, Medical Transcription
Fundamentals and Practice. Then read Assignment 2 in this
study guide.

The medical transcription profession has undergone many
changes throughout the years. In the beginning, physicians
documented patient care themselves on media like parchment papers. As the medical field progressed, medical
record formats became more standardized. First, medical
stenographers began assisting by taking shorthand while
physicians spoke. Long-hand documentation later became
easier with the aid of abbreviations.
As technology progressed, so did the field of medical transcription. Medical transcriptionists first used typewriters to
record physician notes and later graduated to computer systems and software. Today, many transcriptionists work from
home, accessing a system through the Internet to transcribe
or edit medical documents.
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Health Care Record
As you’re probably aware, the patient’s health care, or medical,
record plays in an important role in the career of a medical
transcriptionist. Health care records record individual patient
information and treatment to communicate, evaluate, and
assist in patient care.
As your textbook mentions, there are many different components to a patient’s health care record. A record is made up
of physician orders, laboratory and test information, nursing
notes, operative reports, and many other reports and entries
that work together to give an overall picture of the patient’s
care. Review the description of each type of document found
in a health care record on pages 6–11 of your textbook.

Technology in Transcription
As mentioned, transcription technology has greatly altered
the way a transcriptionist performs daily work. In many ways,
the advancements in transcription technology have made the
transcriptionist’s job easier and more efficient. Gone are the
days of cassette tape dictations. They’ve mostly been replaced
by digital or online dictation and transcription systems, which
allow the transcriptionist to access the dictations via the
same computer system in which he or she will perform the
transcription.
However, even with the most advanced technology, it’s still
important for transcriptionists to understand the basics.
Without a full understanding of grammar, styles, and transcription rules, a transcriptionist will fail to provide quality
transcribed reports.
Read “Transcription Tips” on page 30 and “Proofreading Skills”
on pages 31–32. Review the “Sample Reports” on pages 35–43
to help you understand the layout of various reports and the
“Transcription Practice” on page 44.
It’s normal to feel overwhelmed by the amount of rules, guidelines and tips when you’re first learning to transcribe. Don’t
worry! As you practice, transcription rules and guidelines will
come easier. Also, you always have the ability to use references
and resources if you’re unclear about something in a dictation.
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Editing and Proofreading
As discussed, editing and proofreading are important functions of a transcriptionist’s job. Editing the dictation of a
physician or health care worker may seem difficult at first,
but will become easier that more practice that you get.
Editing includes things like
I

Correcting obvious grammar, punctuation, and medical
errors

I

Correcting verb tense

I

Adding words for better flow

I

Flagging the information for clarification from the
dictating professional

I

Reviewing for medical and other inconsistencies

Remember, if your edit may change the meaning of the
sentence or report different information, you must flag the
information and receive a clarification from the physician or
health care professional. Proofreading means looking for
errors after the report is transcribed. Proofreading includes
recognizing
I

Omitted words that may change the report

I

Incorrect words (such as homophones)

I

Misspelled words

I

Punctuation errors

I

Grammatical errors

After you’ve read the material, complete the “Skills
Challenge” on pages 32–34. Then complete Self-Check 1.
When you’re ready, move on to Assignment 3.
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Self-Check 1
At the end of each section of Medical Transcription 1, you’ll be asked to pause and check
your understanding of what you’ve just read by completing a “Self-Check” exercise.
Answering these questions will help you review what you’ve studied so far. Please
complete Self-Check 1 now.

Indicate whether each statement is True or False.

______

1. New transcriptionists should slow down dictation speeds to ensure they don’t miss any
words.

______

2. New transcriptionists should rely on built-in system spellchecking software to catch
their errors.

______

3. Choosing the wrong prefix or suffix on a medical term can drastically change the
description of medical care for a patient.

______

4. If you’re transcribing a patient’s signs and symptoms, you may be working on a H&P
report.

______

5. Medical dictionaries and style guides are an important part of a transcriptionist’s
reference materials.

Check your answers with those on page 103.
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ASSIGNMENT 3: PERSPECTIVE
ON MEDICAL TRANSCRIPTION
Read pages 47–76 in your textbook, Medical Transcription
Fundamentals and Practice. Then read Assignment 3 in this
study guide.

Dictation and transcription are two distinctly different things.
Dictation is the process a physician or health care worker
uses to relay the information, while transcription is the
actual process a transcription professional uses to copying
and document that information. This means that, as a transcriptionist, you may hear or see things differently than how
a physician or health care professional meant them. It’s your
job not only to type the information, but also to perform
quality control so the exact meaning from the physician or
health care worker is translated onto the transcribed document. For example, your book cites homophones (words that
sound the same but are spelled differently) as an area that
may cause many errors. It’s your job to ensure that terms
like mucus or mucous are reported correctly. In some cases,
you’ll ask for clarification from the physician or health care
worker. However, you should never second-guess what physicians or health care workers mean in their dictation. When in
doubt, you should always query the person dictating.

Types of Reports
Depending on the type of facility or specialty, you’ll transcribe different types of reports, such as the following:
I

H&P

I

SOAP note

I

Chart note

I

Radiology report

I

Operative report

I

Pathology report

I

Consultation
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I

Discharge summary

I

Death summary

I

Autopsy report

Familiarize yourself with these medical reports. Please refer
to the detailed explanation of these reports in Chapter 1 of
your textbook, starting on page 7.

Issues in the Transcription Field
Transcriptionists deal with many issues in this field:
I

Ethics

I

Patient confidentiality

I

Working with foreign accents

I

Increasing typing speed

I

Environmental issues

Many of the issues discussed in this chapter will resolve
themselves as you gain experience. For example, increasing
your transcribing speed and understanding different accents
will become easier with more practice. However, you always
need to be aware of the ethics of working in the medical field
and dealing with patient confidentiality. Also, environmental
issues, particularly ensuring you have the right chair and
wrist support to avoid injuries, are extremely important.
After you’ve read the material, complete the “Skills
Challenge” on pages 74–75. Sample reports, which will
guide you when you’re typing your transcription reports,
begin on page 35. Then complete Self-Check 2. When
you’re ready, move on to Assignment 4.
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Self-Check 2
______

1. Taking a short break every 50 minutes may help transcriptionists avoid carpal tunnel
syndrome.

______

2. The ultimate goal for a transcriptionist should be to become credentialed.

______

3. Courses, such as Medical Terminology 1, help increase your transcription speed.

______

4. Professional medical transcriptionists should be able to provide quality work without
ongoing supervision.

______

5. A transcriptionist will also act in the role of editor by reviewing punctuation, layout, and
grammar.

Check your answers with those on page 103.

ASSIGNMENT 4: STYLE GUIDE
Read pages 77–114 in your textbook, Medical Transcription
Fundamentals and Practice. Then read Assignment 4 in this
study guide.

Chapter 3 is probably one of the most important chapters
in this entire course. The style guide provides information
that allows all transcriptionists to provide common reports
no matter where they work. Chapter 3 of your textbook
discusses English grammar and punctuation basics. It’s
important for you to read and understand these guidelines,
as they’ll help you determine your weaknesses. Many times
students struggle in areas related to punctuation, such as
when and how to use a comma, hyphen, or colon. This
chapter should be reviewed in detail before beginning your
transcription assignments in Chapter 4. Most times, students
will lose points in the areas of punctuation, grammar, and
spelling.
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Proofreading and editing is discussed again in this chapter.
Remember that you’ll proofread and edit your work, not
change the dictator’s style.
Read “How to Transcribe Medical Dictation” on page 44.
Remember that you’re coordinating three of your four
senses—sight, hearing, and touch. As a novice transcriptionist, you’ll want to focus on accuracy, vocabulary, and
punctuation rather than on speed. As you begin to transcribe
in Chapter 4, please refer back to Error Analysis on page 44
of your textbook. This will help guide you as you proofread
your transcription reports.
Although some medical facilities and offices will have styles
specific to their practice, some general guidelines are consistent across facilities, no matter where you work.

Style Guide Basics
Style guides provide basic, not comprehensive, guidelines
for how to handle certain items and situations when transcribing. Style guide basics cover things like common
I

Abbreviations

I

Acronyms

I

Subject-verb agreement

I

Punctuation

I

Capitalization

I

Slang words

I

Eponyms

Even though there are style guide basics, medical facilities
and offices may have guidelines that vary slightly from
accepted practices. Be sure to ask the facility for their guidelines, common abbreviations, or accepted practices for
reporting. If your office or facility doesn’t have one, you may
want to assist them in—at the very least—making a list of
accepted abbreviations to avoid confusion and errors.
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Flagging
Flagging is a way of identifying missing information in a
report. This process is used in the field when you’re unclear
on a word, phrase, sentence, or product the physician or
health care worker has dictated. You’ll also flag material
when you’re submitting transcribed reports for grading.
At times, you won’t be able to figure out a word or phrase in
your transcribed reports. In those cases, you’ll flag the report
by using the underscore key to insert a line. Be sure the
underscore is long enough to include the information later.
Flag the report in the appropriate spot with a note. You can
either type a note and affix it with a clip to the report or
handwrite a flag on a sticky note and affix it to the page.
Although using a sticky note will suffice, it’s more professional to type a note. When flagging a report, you should
include
I

Patient’s name

I

Date of dictation

I

Patient number

I

Page number, paragraph, heading, or dictation time
point where error occurred

I

A few words before or after the problem

I

Your name and date

Flagging a report, both for this class and as a professional in
the field, should be a last resort. Listen to dictations carefully
and use resources such as style guides and medical dictionaries before flagging a report.
Flagging reports involves indicating issues or questions that
need clarification from the physician or health care worker
dictating the report. Flagging should be done when you
I

Can’t determine what the dictating physician is saying

I

Feel that a word is missing

I

Need clarification for any reason
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When transcribing your assignments in this course, you’ll
perform the same flagging function as if you were in the field
by leaving the spot blank where the word or phrase should
be and noting it with a flag.
If you can’t understand what you hear, never guess at what
you think the speaker might mean. This rule applies equally
to words that aren’t pronounced clearly in dictation and to
inconsistencies that you lack the knowledge or expertise to
resolve. When something doesn’t make sense to you, ask for
help from your supervisor, another transcriptionist, or the
dictator, if you have easy access. If you still can’t solve the
problem, leave a blank long enough for the material to be
instated later, and flag the material with an appropriate note.
Here’s an example: Darling, Wendy, dictated 10/24, #05-1283. See blanks under Diagnosis (page 1, line 1) fractured
“left arm” and under Treatment (page 2, line 1) cast on “right
arm.” Contradiction? Pat, 10/27/—. This brief but detailed
flag saves time for the physician, who can clarify the leftor-right problem with a quick look at the patient’s file. It’s
recommended that you use only three flags within a report.
These guidelines are also followed in professionalf settings.

Tips before Flagging
In many cases, you’ll be able to figure out information that
you initially flagged just by going back and rereading the
report or listening to the dictation again. Try these tips
before submitting your assignment with a flag:
I

Slow down (or sometimes speed up) the dictation.

I

Play the sound directly from your computer speaker
instead of through the headset.

I

Complete the report and return to the flagged portions
later.

As a last resort before flagging, try contacting your instructor
for guidance on the issues. However, your instructor won’t
provide assistance on reports that are to be submitted for
grading.
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After you’ve read the material, complete the “Skills
Challenge” on pages 111–114. Then complete SelfCheck 3. When you’re ready, move on to Assignment 5.

Self-Check 3
Indicate whether each statement is True or False.

______

1. Most physicians dictate periods to denote the end of the sentence.

______

2. For the term gravida, transcribe the abbreviation as g.

______

3. When numbers are dictated with age or time, use the numeral (for example, 3) instead
of spelling it out (for example, three).

______

4. Some physicians say “new line” when they really mean “new paragraph.”

______

5. Footnotes aren’t generally used in medical transcription.

Check your answers with those on page 103.

ASSIGNMENT 5: DERMATOLOGY
Read pages 117–137 in your textbook, Medical Transcription
Fundamentals and Practice. Then read Assignment 5 in this
study guide. For the rest of the course, you’ll concentrate on a
specific body system in each assignment. After you finish your
reading, transcribe the assigned dictated reports for Chapter 4.

As your textbook discusses, the skin is the largest organ in
the body. It’s made up of two layers: the epidermis, or outer
layer, and the dermis, or true skin. Review the terminology
that goes with the skin on pages 118–119 of your textbook.
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Diseases
There are many common diseases of the skin:
I

Eczema

I

Dermatitis

I

Ringworm

I

Herpes simplex

I

Acne

I

Basal and squamous cell carcinoma

I

Burns

Read pages 120–126, which will help you understand skin
diseases, causes, history, tests, and treatments. Knowing
these will make transcribing these reports easier.

Treatments and Procedures
If you’re confused about why you need to review treatments
and procedures for specific conditions, remember that reviewing treatments and procedures helps you to understand the
full picture of a specific disease or illness. Additionally, in
some cases, a physician or health care worker will forget to
fully document a patient’s condition. The presence of a treatment or procedure dictation will help alert you to the fact of
missing dictation and documentation, and you can ask the
physician if updates or addendums need to be made.
Treatments and procedures for skin diseases vary. There
may be diagnostic procedures, like a patch, to help determine
more about the skin disease. There may also be surgical procedures like a skin graft to help with severe burns. Review
pages 126–128 in your textbook to understand different
treatments and testing.
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Dermatology Transcription Tips
Here are some transcription tips:
I

Degrees of burns are transcribed as 1st, 2nd, 3rd, and
4th unless the burn depth starts the sentence. Then,
spell out the degree (for example, Second degree).

I

Decubiti doesn’t exist as a plural form of decubitus
ulcers. If dictated, it should be transcribed as “decubitus
ulcers.”

I

Decubitus ulcers are reported in stages written in roman
numerals I through IV. The word stage isn’t capitalized
unless it appears at the beginning of the sentence.

After you’ve read the material, transcribe the assigned
dictated reports. Then complete the “Skills Challenge”
on pages 130–133. Next, complete Self-Check 4. When
you’re ready, move on to Assignment 6. Review the sample reports related to dermatology on pages 134–136.

Instructions for Transcription Labs
Transcription Instructions
The transcription practice labs will allow you to become
familiar with medical terminology and applying what you
learned in anatomy and physiology to the body of your
reports.
When transcribing, even though the dictator is dictating a
first name, use the pronouns he, she, him, or her. For transcriptions with an indication of a female patient, you’ll use
the name Jennifer Summers. For transcriptions with an
indication of a male patient, you’ll use the name Jeffery
Thomas. For transcriptions with a male dictator, you’ll use
the name James Wood, MD. For transcriptions with a female
dictator, you’ll use the name Sonya Pitt, MD. The facility
you’ll transcribing for is the Penn Foster Medical Center.
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Writing Guidelines
Proofread your work carefully. Check for correct spelling,
grammar, punctuation, and capitalization. Format your transcription using 1.25- to 1.5-inch margins and size 12 Times
New Roman font. Type all headings in all capital letters.
Figure 15 shows an example of how you’ll format your
margins and enter your name and student number
within your reports.

1.25″–1.5″

Student Name

Sammy Student

Student Number 1234567
PENN FOSTER MEDICAL CENTER

1.25″–1.5″

1.25″–1.5″
FIGURE 15—Format for Transcriptions

At the top of your transcription, include the following
headings:
I

Your name

I

Your student number

I

Penn Foster Medical Center

If a transcription takes more than one page, put the following
information at the top of each page, starting at page 2:
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I

Patient name

I

Current date

I

Page number
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The signature line should be four lines from the last sentence, and the line should be two and a half inches long
or 25 to 30 underscore spaces. For example, it should look
like this:
______________________________
James Wood, MD
Add two lines, and transcribe the dictator’s initials and your
initials (YI): JW:YI. Add two more lines, and transcribe the
dictated date and the transcribed date. Use the current
month, day, and year for both, as follows.
04/24/20—
04/24/20—
Note: The answer keys for your transcription labs will not be
formatted in this way.

Transcription Lab
Transcribe the following reports for Chapter 4 from the
dictation CD:
I

2. Chart Note (1:00)

I

3. Emergency Department Note (1:15)

I

4. Chart Note (0:15)

I

6. Chart Note (1:00)

I

7. Chart Note (0:30)

Check your transcription lab reports using those provided
in the Transcription Answer Key Supplement found on
your My Courses page.
Note: Don’t send the transcription lab exercises to the
school. These labs are for practice only. You’ll need to send
only the transcriptions you complete for the lesson examinations to the school.
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Self-Check 4
Indicate whether each statement is True or False.

______

1. If a physician dictates subcu, transcribe it as subcutaneous.

______

2. If a patient says he has athlete’s foot, the physician will probably dictate tinea pedis as
the condition.

______

3. The correcting medical spelling for “itching” is pruritis.

______

4. The terms callused and calloused may be used interchangeably when transcribing.

______

5. If a physician dictates that she prescribed Zetar, she may be treating psoriasis.

Check your answers with those on page 103.

ASSIGNMENT 6:
OTORHINOLARYNGOLOGY
Oto/rhin/o/laryng/o/
logy
Oto—word root meaning
“ear”
Rhino—word root meaning “nose”
O—combining vowel (for
ease of pronunciation)
Laryng—word root
meaning “throat”

Read pages 139–157 in your textbook, Medical Transcription
Fundamentals and Practice. Then read Assignment 6 in this
study guide. After you finish your reading, transcribe the
assigned dictated reports for Chapter 5.

Otorhinolaryngology is just a really long way of saying diseases of the ear, nose, and throat. If you break the word
down into medical terminology word parts, it seems much
less intimidating and may make it easier to pronounce.
Physicians in this field are otorhinolaryngologists, or earnose-throat (ENT) doctors. Carefully review the terminology for
this chapter on pages 141–142 of your textbook.

Logy—word root meaning “disease of”
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Diseases
Otorhinolaryngology diseases are very common. You or someone you know may have suffered from a few diseases within
this category. They include
I

Earaches

I

Hay fever

I

Colds

I

Nosebleeds

I

Sore throats

I

Hearing loss

Treatments and Procedures
As you can imagine, treatments and procedures for otorhinolaryngology vary greatly because it covers ears, nose, and
throat diseases. Some ENT treatments and procedures
include
I

Biopsies

I

Otoscopy

I

Rhinoplasty

I

Tonsillectomy

Otorhinolaryngology Transcription Tips
Rhinitis is a commonly misspelled medical term.
After you’ve read the material, transcribe the assigned
dictated reports. Then complete the “Skills Challenge”
on pages 151–153. Next, complete Self-Check 5. When
you’re ready, move on to Assignment 7.
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Transcription Lab
Transcribe the following reports for Chapter 5 from the
dictation CD:
I

1. Chart Note (1:45)

I

2. Chart Note (0:45)

I

3. Chart Note (2:00)

I

6. Emergency Department Note (1:30)

I

7. Emergency Department Note (1:30)

I

8. Chart Note (1:00)

I

9. Operative Report (1:00)

Self-Check 5
Indicate whether each statement is True or False.
______

1. ENT transcriptionists may easily confuse the word contact with the medication Contac.

______

2. Alveoli is the plural form of alveolar.

______

3. Both tympano and myringo mean eardrum.

______

4. If a physician dictates “excessive cerumen” the patient probably has a buildup of
earwax.

______

5. If the physician prescribes an expectorant, you know the patient’s cough is productive.

Check your answers with those on page 104.
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ASSIGNMENT 7:
OPHTHALMOLOGY
Read pages 159–181 in your textbook, Medical Transcription
Fundamentals and Practice. Then read Assignment 7 in this
study guide. After you finish your reading, transcribe the
assigned dictated reports for Chapter 6.

As your textbook describes, ophthalmology deals with
diagnosing and treating eye diseases. For a relatively small
anatomical part, the eye is a complex system. Review the
terminology on pages 161–162 of your textbook for a full
understanding of the terms discusses in this chapter.

Diseases
Many eye diseases are relatively well-known or common.
Many of us suffer from eye impairments like farsightedness
and nearsightedness that require corrective lenses to see.
Other eye diseases include
I

Conjunctivitis

I

Pinkeye

I

Sty

I

Glaucoma

I

Cataract

Treatments and Procedures
Treatments and procedures for eye disease vary greatly. Some
are simple eye examinations, while others are more invasive
surgeries. Examples of eye treatments and procedures
include
I

Vision testing

I

LASIK

I

PRK

I

Tonometry

Lesson 1
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Ophthalmology Transcription Tips
Ophthalmology is a commonly misspelled medical term.
Some basic abbreviations used when transcribing eye
issues are
I

Oculus dexter (OD)—right eye

I

Oculus sinister (OS)—left eye

I

Oculus uterque (OU)—each eye

I

Millimeters of mercury (mmHg)—unit of measurement
used to describe intraocular pressure

After you’ve read the material, transcribe the assigned
dictated reports. Then complete the “Skills Challenge”
on pages 176–177. Next, complete Self-Check 6. Review
the sample reports on pages 178–180 of your textbook
to gain a better understanding of transcribed ophthalmology reports. When you’re ready, take the Lesson 1
Examination.

Transcription Lab
Transcribe all reports for Chapter 6 from the dictation CD:
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I

1. Chart Note (0:45)

I

2. Chart Note (3:00)

I

4. Chart Note (0:30)

I

7. Operative Report (4:45)

Medical Transcription 1

Self-Check 6
Indicate whether each statement is True or False.

______

1. When a physician dictates the sclera of both eyes, transcribe it in the plural form as
sclerae.

______

2. If a physician dictates myopia, you know the patient has nearsightedness.

______

3. If a physician prescribes Tobrex for a patient, the patient may have a viral eye
infection.

______

4. If a physician dictates, “OD redness and swelling,” he is referring to the right eye.

______

5. A physician may prescribe cromolyn for allergic conjunctivitis.

Check your answers with those on page 104.
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Proficiency is the key to medical transcription. Students are required to make the
necessary corrections on the following corrected practice transcriptions and submit
the corrected practice transcriptions and checklist along with their exam. If the
required practice transcriptions aren’t received with the exam, it will be returned
ungraded.
Practice for Exam 039807

Chapter/Transcription

Chart Note

4.2

Emergency Department Note

4.3

Chart Note

4.4

Chart Note

4.6

Chart Note

4.7

Chart Note

5.1

Chart Note

5.3

Emergency Department Note

5.6

Operative Report

5.9

Operative Report

6.7
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Yes

No

Student Name

Student Number
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